
Rev. 42015A-07/2012, 42015AJ1-04/14

®
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応用記述

AVR1936 : XPLORE開始の手引き

Atmel 8ﾋﾞｯﾄ ﾏｲｸﾛ ｺﾝﾄﾛｰﾗ
要点

● XPLORE評価ｷｯﾄを支援
● Atmel® ATxmega32A4(U)/D4のPDIﾌﾟﾛｸﾞﾗﾐﾝｸﾞ
● Atmel Studioまたは/とIAR Embedded Workbench®を使用する実演例演習
● Atmel JTAGICE mkⅡまたは3を利用するﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ

序説

この資料はXPLORE評価ｷｯﾄを使用してAtmel ATxmega32A4(U)/D4ﾏｲｸﾛ ｺﾝﾄﾛｰﾗを開始す
る方法についての情報を含みます。

この資料の最初の4つの章は設計と実装のｿﾌﾄｳｪｱ(Atmel StudioのｲﾝｽﾄｰﾙとAtmel AVR®用
IARTM Embedded Workbenchのｲﾝｽﾄｰﾙ)、ｺﾝﾊﾟｲﾙ、ﾌﾟﾛｸﾞﾗﾐﾝｸﾞ、それとﾌｧｰﾑｳｪｱ設計をﾃﾞﾊﾞｯ
ｸﾞするのに必要とされる実演演習ｲﾝﾀｰﾌｪｰｽ ｿﾌﾄｳｪｱを始める前に(仮想COMﾎﾟｰﾄ ﾄﾞﾗｲﾊﾞのｲ
ﾝｽﾄｰﾙ/更新)についての情報を含みます。次の2つの章は実演設計例(開始実演例の説明)に
対する説明と、Atmel XMEGA®ﾃﾞﾊﾞｲｽのﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ(ｺﾝﾊﾟｲﾙとﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ)とPDI実装ﾌﾟ
ﾛｸﾞﾗﾐﾝｸﾞ(ISP)(XPLORE上のAtmel XMEGAの実装ﾌﾟﾛｸﾞﾗﾐﾝｸﾞ)用のXPLORE評価ｷｯﾄ基板構成
設定方法(ﾊｰﾄﾞｳｪｱ構成設定)についての詳細な手順を含みます。ﾌﾟﾛｼﾞｪｸﾄを作成してﾌｧｰﾑ
ｳｪｱ設計ｺｰﾄﾞをｺﾝﾊﾟｲﾙし、Atmel Studio(Atmel Studio内の組み込みｺﾝﾊﾟｲﾗでのｺﾝﾊﾟｲﾙとﾃﾞ
ﾊﾞｯｸﾞ)とJTAGICE mkⅡまたはJTAGICE 3(IARとAtmel Studioでのｺﾝﾊﾟｲﾙとﾃﾞﾊﾞｯｸﾞ)を使用し
てXPLORE評価基板上の設計のﾃﾞﾊﾞｯｸﾞを開始する方法を実演する3つの章もあります。最終
章は参照を含みます。



AVR1936 : XPLORE開始の手引き [応用記述] 2

目次

 1. Atmel Studioのｲﾝｽﾄｰﾙ ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 3
 2. Atmel AVR用IAR Embedded Workbenchのｲﾝｽﾄｰﾙ ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 3
 3. 仮想COMﾎﾟｰﾄ ﾄﾞﾗｲﾊﾞのｲﾝｽﾄｰﾙ/更新 ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 3
 4. Puttyｿﾌﾄｳｪｱのｲﾝｽﾄｰﾙ ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 4
 5. 拡張ﾂｰﾙのｲﾝｽﾄｰﾙ(任意選択) ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 4
 6. 開始実演例の説明 ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 4
 7. ﾊｰﾄﾞｳｪｱ構成設定 ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 4
 8. ｺﾝﾊﾟｲﾙとﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 7
 8.1. Atmel Studio内の組み込みｺﾝﾊﾟｲﾗでのｺﾝﾊﾟｲﾙとﾃﾞﾊﾞｯｸﾞ ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 7
 8.2. Atmel StudioとIARでのｺﾝﾊﾟｲﾙとﾃﾞﾊﾞｯｸﾞ ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 12

 9. XPLORE上のAtmel XMEGAの実装ﾌﾟﾛｸﾞﾗﾐﾝｸﾞ ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 15
10. 参照 ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 17
 10.1. ｵﾝﾗｲﾝ参照資料 ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 17
 10.2. 設計ｿﾌﾄｳｪｱと通信装置ﾄﾞﾗｲﾊﾞ ・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・・ 17



AVR1936 : XPLORE開始の手引き [応用記述] 3

1. Atmel Studioのｲﾝｽﾄｰﾙ
Atmel Studio(6.0版またはそれ以降版)は組み込みｱｾﾝﾌﾞﾗ、C/C++ｺﾝﾊﾟｲﾗ(本来のGNU、WINAVR GNU)だけでなく、Atmelﾏｲｸﾛ ｺ
ﾝﾄﾛｰﾗ設計用のｼﾐｭﾚｰﾀと前置ﾃﾞﾊﾞｯｶﾞも含みます。この資料で記述されない有用な機能もありますが、それらはAtmel Studioｿﾌﾄｳｪ
ｱのﾍﾙﾌﾟ手引書から容易に得られます。Atmel AVRﾌﾟﾛｸﾞﾗﾐﾝｸﾞ/ﾃﾞﾊﾞｯｸﾞ ﾂｰﾙ(JTAGICE mkⅡまたはJTAGICE 3)はXPLORE評価ｷｯ
ﾄ基板でAVR XMEGA系統ﾏｲｸﾛ ｺﾝﾄﾛｰﾗの実装ﾌﾟﾛｸﾞﾗﾐﾝｸﾞ(ISP)とｲﾝｻｰｷｯﾄ ｴﾐｭﾚｰｼｮﾝ(ICE)を実効するためにAtmel Studioｿﾌﾄｳｪ
ｱと共に使用することもできます。

XPLORE評価ｷｯﾄ基板とで開始するために、AtmelのｳｪﾌﾞｻｲﾄからAtmel Studioｲﾝｽﾄｰﾗ ｿﾌﾄｳｪｱと公開記述PDFをﾀﾞｳﾝﾛｰﾄﾞしてくだ
さい。ｿﾌﾄｳｪｱ公開記述を読み、その後にｲﾝｽﾄｰﾗを走らせ、ｿﾌﾄｳｪｱのｲﾝｽﾄｰﾙを完了するための指示に従ってください。

ﾌﾟﾛｼﾞｪｸﾄを開始し、組み込みC/C++ｺﾝﾊﾟｲﾗを使用してｺｰﾄﾞをｺﾝﾊﾟｲﾙする方法はこの資料の参照章の[10]から得られます。

2. Atmel AVR用IAR Embedded Workbenchのｲﾝｽﾄｰﾙ
Atmel AVR用のIAR EWｷｯｸｽﾀｰﾄ版、期間制限版、または完全版を含むIARTM Embedded Workbench 6.11またはそれ以降版は
Atmelのﾏｲｸﾛ ｺﾝﾄﾛｰﾗを支援する任意選択の第三者のｺﾝﾊﾟｲﾗとﾃﾞﾊﾞｯｸﾞ ﾂｰﾙです。

IAR Embedded Workbenchｲﾝｽﾄｰﾙ ｿﾌﾄｳｪｱのﾀﾞｳﾝﾛｰﾄﾞ ｳｪﾌﾞ ﾘﾝｸは、この資料の参照章の[11]で得られます。

ｿﾌﾄｳｪｱのｲﾝｽﾄｰﾙを開始するには、"auto run"応用を選択し、そして"Install IAR Embedded Workbench"を選択してください。

ｲﾝｽﾄｰﾙ中、許諾期間が過ぎていなければ、IAR Systemsから得た以前の版のIAR Embedded Workbench用と同じ"許諾番号"と"許
諾鍵"を使用することが可能です。

何か技術支援またはIARｿﾌﾄｳｪｱ許諾に関連する疑問があれば、IAR Systemsの技術支援にお問い合わせください。

IARのｲﾝｽﾄｰﾙ中に既定設定を使用することも推奨されます。IAR EWでﾌﾟﾛｼﾞｪｸﾄを開始してｺｰﾄﾞをｺﾝﾊﾟｲﾙする方法はこの資料の
8.2.項で記述されます。

3. 仮想COMﾎﾟｰﾄ ﾄﾞﾗｲﾊﾞのｲﾝｽﾄｰﾙ/更新
USBｹｰﾌﾞﾙをXPLORE評価ｷｯﾄ基板のUSBｺﾈｸﾀ(J4)からﾊﾟｰｿﾅﾙ ｺﾝﾋﾟｭｰﾀ(PC)またはﾗｯﾌﾟﾄｯﾌﾟのUSBﾎﾟｰﾄに接続する前に、USB- 
COM模倣動作を実行するために基板上のFTDIﾃﾞﾊﾞｲｽ(FT232RL)に対し、あなたのｼｽﾃﾑにFuture Technology Devices Internation 
al Ltd(FTDI)の仮想COMﾎﾟｰﾄ(VCP:Virtual COM Port)ｿﾌﾄｳｪｱをﾀﾞｳﾝﾛｰﾄﾞしてｲﾝｽﾄｰﾙ/更新することが必要とされます。

Windows®用の"CD x_xx_xx WHQL Certified.zip"のようなVCPｿﾌﾄｳｪｱ ﾄﾞﾗｲﾊﾞzipﾌｧｲﾙ(Microsoft®からの32ﾋﾞｯﾄと64ﾋﾞｯﾄのWindowsｵ
ﾍﾟﾚｰﾃｨﾝｸﾞ ｼｽﾃﾑ(OS)に対して異なるzipﾌｧｲﾙが使用されます。)は、最初にFuture Technology Devices Internation al Ltdのｳｪﾌﾞｻ
ｲﾄからあなたのｼｽﾃﾑ(PC/ﾗｯﾌﾟﾄｯﾌﾟ)にﾀﾞｳﾝﾛｰﾄﾞすることができます。

XPLORE基板からPCまたはﾗｯﾌﾟﾄｯﾌﾟへのUSBｹｰﾌﾞﾙ接続後、"CD x_xx_xx WHQL Certified"ﾃﾞｨﾚｸﾄﾘからｿﾌﾄｳｪｱ ﾄﾞﾗｲﾊﾞを更新する
ために閲覧することができます。更新/ｲﾝｽﾄｰﾙのためにVCPｿﾌﾄｳｪｱ ﾄﾞﾗｲﾊﾞを選ぶように指示するために"新しいﾊｰﾄﾞｳｪｱ発見"での
"USB接続の自動検出"ﾒｯｾｰｼﾞが表示されない場合、USBｹｰﾌﾞﾙを外してその後に再びPCのUSBﾎﾟｰﾄに嵌め込み、ﾃﾞｽｸﾄｯﾌﾟ ｳｨﾝﾄﾞ 
ｳで"ﾏｲ ｺﾝﾋﾟｭｰﾀ"の"ﾌﾟﾛﾊﾟﾃｨ"設定、または"ｺﾝﾋﾟｭｰﾀ"から"ｼｽﾃﾑのﾌﾟﾛﾊﾟﾃｨ"任意選択の"ﾊｰﾄﾞｳｪｱ"ﾀﾌﾞ ｳｨﾝﾄﾞｳから"ﾃﾞﾊﾞｲｽ ﾏﾈｰ
ｼﾞｬ"を手動で開いてください。次に、"ﾃﾞﾊﾞｲｽ ﾏﾈｰｼﾞｬ"ｳｨﾝﾄﾞｳから、図3-1.で示されるように"USB Serial Port"または"FT232R USB 
UART"設定(いくつかのｼｽﾃﾑは"その他のﾃﾞﾊﾞｲｽ"設定下で示されます。)の検出を得るために"活動"ﾒﾆｭｰから"ﾊｰﾄﾞｳｪｱ変更を走
査"を選択することができます。また、"ﾄﾞﾗｲﾊﾞ ｿﾌﾄｳｪｱを更新"任意選択を選ぶためにﾏｳｽの"右ｸﾘｯｸ"を使用し、最後に解凍された
"CD x_xx_xx WHQL Certified"ﾃﾞｨﾚｸﾄﾘからｿﾌﾄｳｪｱ ﾄﾞﾗｲﾊﾞ ﾌｧｲﾙを更新するために、あなたのｼｽﾃﾑを通して閲覧してください。ｿﾌﾄ
ｳｪｱ ﾄﾞﾗｲﾊﾞ更新成功後、"ﾃﾞﾊﾞｲｽ ﾄﾞﾗｲﾊﾞ"ｳｨﾝﾄﾞｳの"ﾎﾟｰﾄ (COMとLPTx)"任意選択下で次の"USB Serial PORT"設定に新しいCOM
ﾎﾟｰﾄが表示されます。

図3-1. PuTTY形態設定ｳｨﾝﾄﾞｳとﾃﾞﾊﾞｲｽ ﾏﾈｰｼﾞｬ ｳｨﾝﾄﾞｳ

http://www.atmel.com/Images/as6installer-6.0.1843-readme.pdf
http://www.atmel.com/microsite/atmel_studio6/default.aspx
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異なるWindowsｵﾍﾟﾚｰﾃｨﾝｸﾞ ｼｽﾃﾑでVCPｿﾌﾄｳｪｱ ﾄﾞﾗｲﾊﾞを成功裏に更新/ｲﾝｽﾄｰﾙする方法についてのより多くの情報に関しては、
Future Technology Devices Internation al Ltdのｳｪﾌﾞｻｲﾄからｿﾌﾄｳｪｱ ﾄﾞﾗｲﾊﾞ ﾀﾞｳﾝﾛｰﾄﾞ指示を再調査してください。

VCPﾄﾞﾗｲﾊﾞ ｲﾝｽﾄｰﾙ ｿﾌﾄｳｪｱ ﾀﾞｳﾝﾛｰﾄﾞのｳｪﾌﾞ ﾘﾝｸはこの資料の参照章の[9]から得られます。

4. Puttyｿﾌﾄｳｪｱのｲﾝｽﾄｰﾙ
USB-COM模倣動作ﾃﾞｰﾀを表示するための端末画面を使用するために、各種ｵﾍﾟﾚｰﾃｨﾝｸﾞ ｼｽﾃﾑを支援するPuttyｿﾌﾄｳｪｱのｲﾝｽ
ﾄｰﾙも必要とされます。

Puttyｲﾝｽﾄｰﾙ ｿﾌﾄｳｪｱ ﾀﾞｳﾝﾛｰﾄﾞのｳｪﾌﾞ ﾘﾝｸはこの資料の参照章の[14]から得られます。

5. 拡張ﾂｰﾙのｲﾝｽﾄｰﾙ(任意選択)
Puttyｿﾌﾄｳｪｱを使用する他にも、使用者は拡張ﾂｰﾙとしてAtmel Studio(6.0版またはそれ以降版)に任意選択の端末ｳｨﾝﾄﾞｳをｲﾝｽﾄｰ
ﾙすることもできます。以下の手順はｲﾝｽﾄｰﾙ手順を記述します。

拡張管理部(Extension Manager)はAtmel Studioｿﾌﾄｳｪｱへの各種ﾌﾟﾗｸﾞｲﾝ追加を手助けします。

段階1. "Tool"そしてその後に"Extension Manager"任意選択を選ぶことによってAtmel Studioｿﾌﾄｳｪｱで拡張管理部を開いてくださ
い。

段階2. "Extension Manager"ｳｨﾝﾄﾞｳから"Available Downloads(利用可能なﾀﾞｳﾝﾛｰﾄﾞ)"任意選択をｸﾘｯｸしてください。

段階3. ﾀﾞｳﾝﾛｰﾄﾞするために"Terminal Window Plugin(端末ｳｨﾝﾄﾞｳ ﾌﾟﾗｸﾞｲﾝ)"任意選択をｸﾘｯｸしてください。

段階4. ｱｶｳﾝﾄまたはｻｲﾝｲﾝを作成してください。

注: 新しいｱｶｳﾝﾄを作成する場合、ｱｶｳﾝﾄを作成し、Atmel Studio 6.0を再始動して上の手順を繰り返してください。

段階5. 一旦拡張がﾀﾞｳﾝﾛｰﾄﾞされると、下側の状態ﾊﾞｰで"You must restart Atmel Studio in order for the change to take effect(変更
が有効になるためにAtmel Studioを再始動しなければなりません。)"が表示されます。

段階6. Atmel Studioを再始動してください。

6. 開始実演例の説明
この開始実演例はAtmelの意義が何かについて使用者に知らせるまたは気付かせるように構成設定され、そしてそれはAtmelが何を
表すかでもあります。実際に、それは"PASSION"、"INTEGRITY"、"TEAMWORK"、"ACHIEVMENT"、"ACCOUNTABILITY"の組
み合わせです。これの目標はAtmel AVR XMEGAﾏｲｸﾛ ｺﾝﾄﾛｰﾗのUARTﾎﾟｰﾄからFT232RL(FTDI)ﾃﾞﾊﾞｲｽへAtmelの意義ﾒｯｾｰｼﾞ
(ASCII形式文字)を送り、その後にそれらをUSBを通して仮想COMﾎﾟｰﾄ(VCP)模倣動作ｲﾝﾀｰﾌｪｰｽへ渡し、最後に送信されたﾒｯｾｰ
ｼﾞをﾊﾟｰｿﾅﾙ ｺﾝﾋﾟｭｰﾀ(PC)またはﾗｯﾌﾟﾄｯﾌﾟの端末画面に表示することによって達成されます。表示されたﾒｯｾｰｼﾞはPC/ﾗｯﾌﾟﾄｯﾌﾟの
端末画面から"Agree(同意)"を意味するASCII文字'A'を入力するように使用者にも指示し、その後にそれをUSB-UARTｲﾝﾀｰﾌｪｰｽを
通してXMEGAﾏｲｸﾛ ｺﾝﾄﾛｰﾗへ送り戻し、最後にﾏｲｸﾛ ｺﾝﾄﾛｰﾗの入出力ﾎﾟｰﾄEを通してXPLORE評価ｷｯﾄ基板に置かれたLEDに2
進の'A'値(1010 : LED3=OFF(1)、LED2=ON(0)、LED1=OFF(1)、LED0=ON(0))を表示します。

図6-1.はこの開始実演設計例に対する主な部品とそれのｲﾝﾀｰﾌｪｰｽ接続を示します。実際の実装についてのより多くの詳細に関し
てはﾌﾟﾛｼﾞｪｸﾄzipﾌｧｲﾙから設計ｿｰｽ ｺｰﾄﾞを参照してください。

図6-1. 開始実演例構成図
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7. ﾊｰﾄﾞｳｪｱ構成設定
XPLORE評価ｷｯﾄ基板は44ﾋﾟﾝVQFP外囲器のAtmel AVR ATxmega32A4、ATxmega32A4U、ATxmega32D4ﾏｲｸﾛ ｺﾝﾄﾛｰﾗを支援す
るように設計され、また別の外囲器形式を支援するための容易な変更を許す、44ﾋﾟﾝTQFP外囲器の配線ﾊﾟﾀｰﾝと共にやって来ま
す。現在、既定ﾃﾞﾊﾞｲｽとしてXPLORE評価ｷｯﾄ基板上にATxmega32A4Uが組み上げられます。

本章は開始実演設計例の演習のためにXPLORE評価ｷｯﾄ基板を構成設定する段階的手順を示します。図7-1.はAVR JTAGICE mk 
Ⅱを使用する、XPLORE評価ｷｯﾄ基板上のXMEGAﾏｲｸﾛ ｺﾝﾄﾛｰﾗのPDIﾌﾟﾛｸﾞﾗﾐﾝｸﾞとﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞの接続を示します。JTAGICE m 
kⅡのPDIｺﾈｸﾀが使用される、またはそれのPDIｺﾈｸﾀか線でJTAGICE 3が使用される場合は図7-2.で示される僅かに異なるPDI ISP 
/ﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ接続法を参照してください。
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図7-1. それの線接続でAVR JTAGICE mkⅡを使用する開始実演例ﾊｰﾄﾞｳｪｱ構成設定

図7-2. AVR JTAGICE mkⅡまたはJTAGICE 3での他のPID接続法
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ﾊｰﾄﾞｳｪｱ構成設定手順:

段階1. XPLORE基板のJPL8ﾍｯﾀﾞの左側にｼﾞｬﾝﾊﾟを設定してください。

注: そのような方法でのこのｼﾞｬﾝﾊﾟ設定はUSBｺﾈｸﾀ(J4)からのVBUSﾋﾟﾝを(LDO)低損失直線調整器(U3:LT3022)の入力ﾋﾟﾝに
接続します。

段階2. JPL9ﾍｯﾀﾞの左側にｼﾞｬﾝﾊﾟを設定してください。

注: そのような方法でのこのｼﾞｬﾝﾊﾟ設定はLDO調整器(U3:LT3022)のLDO_OUTﾋﾟﾝをJP2ﾍｯﾀﾞのVCC網に接続し、そしてこれ
はJP2ﾍｯﾀﾞにｼﾞｬﾝﾊﾟが設定された時にAtmel XMEGAﾏｲｸﾛ ｺﾝﾄﾛｰﾗのVCC/AVCCﾋﾟﾝに電力を供給するのにも使用され
ます。

段階3. H7ﾍｯﾀﾞの左側にｼﾞｬﾝﾊﾟを設定してください。

注: そのような方法でのこのｼﾞｬﾝﾊﾟ設定はLDO調整器(U3:LT3022)の出力に接続された分圧回路から3.3V出力設定を選びま
す。

段階4. JP2ﾍｯﾀﾞにｼﾞｬﾝﾊﾟを設定してください。

注: このｼﾞｬﾝﾊﾟ設定はJPL9ﾍｯﾀﾞからのVCC網をJP2ﾍｯﾀﾞのU1_VCCに接続します。

段階5. JP0ﾍｯﾀﾞにｼﾞｬﾝﾊﾟを設定してください。

注: そのような方法でのこのｼﾞｬﾝﾊﾟ設定はUART通信のためにXMEGAﾏｲｸﾛ ｺﾝﾄﾛｰﾗ(U1)のRXD0/PD2ﾋﾟﾝをFTDIﾃﾞﾊﾞｲｽ
(U2 :FT232RL)のTXDﾋﾟﾝに接続します。

段階6. JP1ﾍｯﾀﾞにｼﾞｬﾝﾊﾟを設定してください。

注: そのような方法でのこのｼﾞｬﾝﾊﾟ設定はUART通信のためにXMEGAﾏｲｸﾛ ｺﾝﾄﾛｰﾗ(U1)のTXD0/PD3ﾋﾟﾝをFTDIﾃﾞﾊﾞｲｽ
(U2 :FT232RL)のRXDﾋﾟﾝに接続します。

段階7. JPL0ﾍｯﾀﾞの左側にｼﾞｬﾝﾊﾟを設定してください。

注: そのような方法でのこのｼﾞｬﾝﾊﾟ設定はXMEGAﾏｲｸﾛ ｺﾝﾄﾛｰﾗ(U1)のﾎﾟｰﾄEの0番ﾋﾟﾝ(PE0)をLED0に接続します。

段階8. JPL1ﾍｯﾀﾞの左側にｼﾞｬﾝﾊﾟを設定してください。

注: そのような方法でのこのｼﾞｬﾝﾊﾟ設定はXMEGAﾏｲｸﾛ ｺﾝﾄﾛｰﾗ(U1)のﾎﾟｰﾄEの1番ﾋﾟﾝ(PE1)をLED1に接続します。

段階9. JPL2ﾍｯﾀﾞの左側にｼﾞｬﾝﾊﾟを設定してください。

注: そのような方法でのこのｼﾞｬﾝﾊﾟ設定はXMEGAﾏｲｸﾛ ｺﾝﾄﾛｰﾗ(U1)のﾎﾟｰﾄEの2番ﾋﾟﾝ(PE2)をLED2に接続します。

段階10. JPL3ﾍｯﾀﾞの左側にｼﾞｬﾝﾊﾟを設定してください。

注: そのような方法でのこのｼﾞｬﾝﾊﾟ設定はXMEGAﾏｲｸﾛ ｺﾝﾄﾛｰﾗ(U1)のﾎﾟｰﾄEの3番ﾋﾟﾝ(PE3)をLED3に接続します。

重要な構成設定:

次の段階へ進む前に、FT232RLのVCPｿﾌﾄｳｪｱ ﾄﾞﾗｲﾊﾞ ｲﾝｽﾄｰﾙ ﾌｧｲﾙをﾀﾞｳﾝﾛｰﾄﾞし、この資料の前の3.章で案内されたようにあなた
のWindowsｼｽﾃﾑ(OS)にそれをｲﾝｽﾄｰﾙするためにｲﾝｽﾄｰﾙの手引きに従ってください。このｿﾌﾄｳｪｱ ｲﾝｽﾄｰﾙ段階はWindows PCへ
のFT232RLﾃﾞﾊﾞｲｽのUSB接続に必要とされます。

段階11. USBﾊﾞｽ ｲﾝﾀｰﾌｪｰｽからのVBUS接続を通して基板に通電するために、XPLORE評価ｷｯﾄ基板と共に含まれるUSBｹｰﾌﾞﾙを
PCのUSBﾎﾟｰﾄからXPLORE評価ｷｯﾄ基板のUSBｺﾈｸﾀ(J4)に接続してください。

段階12. 図7-1.で示されるようにJTAGｱﾀﾞﾌﾟﾀ基板をAtmel AVR JTAGICE mkⅡｺﾈｸﾀに接続してください。

注: 他のPDI/ﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ接続法が使用される場合、この段階を飛ばすことができますが、図7-2.で示されるように適切な
接続を構成設定することがきっと必要です。

この開始実演例で作業する前に、Atmel StudioｿﾌﾄｳｪｱのｲﾝｽﾄｰﾙによってAtmel JTAGICE mkⅡ/3用のUSBｿﾌﾄｳｪｱ
(AVR Jungo USB)も正しく構成設定されるべきです。

段階13. USBｹｰﾌﾞﾙをAVR JTAGICE mkⅡからPCのUSBﾎﾟｰﾄに接続してください。

注: JTAGICE mkⅡの代わりにJTAGICE 3が使用される場合、USBｹｰﾌﾞﾙをAVR JTAGICE 3からPCのUSBﾎﾟｰﾄに接続して
ください。

段階14. 図7-1.で示されるように赤線をJTAGICE mkⅡのJTAGｱﾀﾞﾌﾟﾀからXPLORE評価ｷｯﾄ基板上のH6ﾍｯﾀﾞの1番ﾋﾟﾝ(PDI_DATA)
に接続してください。

注: 他のPDI/ﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ接続法が使用される場合、この段階を飛ばすことができますが、図7-2.で示されるように適切な
接続を構成設定することがきっと必要です。

段階15. 図7-1.で示されるように紫線をJTAGICE mkⅡのJTAGｱﾀﾞﾌﾟﾀからXPLORE評価ｷｯﾄ基板上のH6ﾍｯﾀﾞの2番ﾋﾟﾝ(VTG/U1_VC 

C_IN/VCC)に接続してください。

注: 他のPDI/ﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ接続法が使用される場合、この段階を飛ばすことができますが、図7-2.で示されるように適切な
接続を構成設定することがきっと必要です。

段階16. 図7-1.で示されるように緑線をJTAGICE mkⅡのJTAGｱﾀﾞﾌﾟﾀからXPLORE評価ｷｯﾄ基板上のH6ﾍｯﾀﾞの5番ﾋﾟﾝ(PDI_CLK)に
接続してください。

注: 他のPDI/ﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ接続法が使用される場合、この段階を飛ばすことができますが、図7-2.で示されるように適切な
接続を構成設定することがきっと必要です。



AVR1936 : XPLORE開始の手引き [応用記述] 7

段階17. 図7-1.で示されるように白線をJTAGICE mkⅡのJTAGｱﾀﾞﾌﾟﾀからXPLORE評価ｷｯﾄ基板上のH6ﾍｯﾀﾞの6番ﾋﾟﾝ(GND)に接続
してください。

注: 他のPDI/ﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ接続法が使用される場合、この段階を飛ばすことができますが、図7-2.で示されるように適切な
接続を構成設定することがきっと必要です。

注: XPLORE評価ｷｯﾄ基板は外部DC電力供給または電池供給によって通電することもできます。この開始実演例は基板通
電のために1つの方法だけを示します。基板の他の通電方法の詳細についてはXPLOREﾊｰﾄﾞｳｪｱ使用者の手引きを参
照してください。

8. ｺﾝﾊﾟｲﾙとﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞ
本章はAtmel StudioとIAR Embedded Workbenchでの両方の組み込みｺﾝﾊﾟｲﾗで開始実演例ﾌﾟﾛｼﾞｪｸﾄを作成、ｺﾝﾊﾟｲﾙ、構築し、そ
の後にAtmel Studioを使用してﾃﾞﾊﾞｲｽのﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞを実行する方法を記述します。Atmel Studioの組み込みｺﾝﾊﾟｲﾗを利用する
開発については8.1.項を読んでください。IAR Embedded Workbenchを使用する開発については8.2.項を読んでください。

8.1. Atmel Studio内の組み込みｺﾝﾊﾟｲﾗでのｺﾝﾊﾟｲﾙとﾃﾞﾊﾞｯｸﾞ

Atmel Studio内の組み込みｺﾝﾊﾟｲﾗを使用してAtmel ATxmega32A4Uﾃﾞﾊﾞｲｽ用のﾌﾟﾛｼﾞｪｸﾄを開始するには下の記述のように行って
ください。

段階1. この開始実演例を演習するためのCｿｰｽ ｺｰﾄﾞとﾍｯﾀﾞ ﾌｧｲﾙを含む"Xplore_Getting_Started"実演例ﾃﾞｨﾚｸﾄﾘを構成設定する
のに"Cﾄﾞﾗｲﾌﾞ"のようなﾛｰｶﾙ ﾄﾞﾗｲﾌﾞにこのXPLORE開始資料と共に来る"Xplore_Getting_Started.zip"ﾌｧｲﾙを解凍してくださ
い。

段階2. ﾃﾞｽｸﾄｯﾌﾟ ｺﾝﾋﾟｭｰﾀから、"Atmel Studio"ｿﾌﾄｳｪｱを開始するために"Atmel Studio"ﾃﾞｽｸﾄｯﾌﾟ ｱｲｺﾝをﾀﾞﾌﾞﾙｸﾘｯｸしてください。

段階3. "New Project"ｳｨﾝﾄﾞｳを開くために、"Start Page"ｳｨﾝﾄﾞｳから"New Project..."任意選択、または"File"⇒"New"を、その後にｿ
ﾌﾄｳｪｱ ﾒﾆｭｰから"Project..."任意選択を選んでください。

段階4. "Installed Templates"として"C/C++"を選び、"GCC C Executable project"任意選択をｸﾘｯｸし、"Create directry for solutio 
n"任意選択をﾁｪｯｸ解除し、そして"GccApplication1"のような"Project Name"を入力し、最後に従うべきﾌﾟﾛｼﾞｪｸﾄ(位置)"Loca 
tion"を構成設定し、その後に"OK"釦を押してください。

注: このような場合に"GccApplication1"ﾌﾟﾛｼﾞｪｸﾄ ﾌｫﾙﾀﾞと共に"C:\Xplore_Getting_Started\Atmel\Getting_Started\GccAppli 
cation1\"ﾃﾞｨﾚｸﾄﾘ ﾊﾟｽが自動的に作成されます。

段階5. "Device Selection"ｳｨﾝﾄﾞｳの最後へｽｸﾛｰﾙ ﾀﾞｳﾝし、"Atcmega32A4U"ﾃﾞﾊﾞｲｽを選び、そして再び"OK"釦を押してください。

段階6. "Solution Explorer"ｳｨﾝﾄﾞｳから"GccApplication1.c"
雛形ﾌｧｲﾙを強調表示にし、そして図8-1.で示される
ように"Remove"任意選択を選ぶのにﾏｳｽの右ｸﾘｯｸ
を使用してください。

図8-1. Atmel StudioでのSolution Explorerｳｨﾝﾄﾞｳ

段階7. "GccApplication1.c"雛形ﾌｧｲﾙを削除するために"Atmel Studio"ﾀﾞｲｱﾛｸﾞ ｳｨﾝﾄﾞｳから"Delete"釦を選んでください。

段階8. "Solution Explorer"ｳｨﾝﾄﾞｳから"GccApplication1"を強調表示にし、そして"Add"を選ぶのにﾏｳｽの右ｸﾘｯｸを使用し、その後
に"Existing item..."任意選択を選んでください。

段階9. "C:\Xplore_Getting_Started\Atmel\Getting_Started\example_code\"ﾃﾞｨﾚｸﾄﾘから"Getting_Started_XPLORE.c"ﾌｧｲﾙを選択
し、そして"Add"釦を選ぶ前に、"Ctrl"ｷｰﾎﾞｰﾄﾞ ｷｰを押下して"usart_driver.c"、"usart_driver.h"、"avr_compiler.h"ﾌｧｲﾙも共
に選択してください。
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段階10. 全ての設定とﾌﾟﾛｼﾞｪｸﾄ全体を保存するためにAtmel Studioｳｨﾝﾄﾞｳから"File"その後に"Save all"任意選択を選んでください。

注: "example_code"ﾌｫﾙﾀﾞからAtmel Studio内の現在の設計ﾃﾞｨﾚｸﾄﾘへ"Getting_Started_XPLORE.c"、"usart_driver.c"、"us 
art_driver.h"、"avr_compiler.h"ﾌｧｲﾙのような例設計ｿｰｽ ﾌｧｲﾙの追加により、それらのﾌｧｲﾙの複製が保存され、現在の
設計ﾃﾞｨﾚｸﾄﾘ("C:\Xplore_Getting_Started\Atmel\Getting_Started\GccApplication1\")に格納されます。

段階11. Atmel Studioｿﾌﾄｳｪｱでﾌｧｲﾙを開くために"Solution Explorer"ｳｨﾝﾄﾞｳから"Getting_Started_XPLORE.c"ﾌｧｲﾙをﾀﾞﾌﾞﾙｸﾘｯｸし
てください。

段階12. ｺｰﾄﾞをｺﾝﾊﾟｲﾙしてﾌﾟﾛｼﾞｪｸﾄを再構築するために"Atmel Studio"ｳｨﾝﾄﾞｳから"Build"を選択して"Rebuild Solution"を選んでく
ださい。

注: Atmel Studioの既定ｺﾝﾊﾟｲﾗは組み込まれた本来のGNUｺﾝﾊﾟｲﾗを意味する"Native"に構成設定されます。使用者はAt 
mel Studioｿﾌﾄｳｪｱ内での他の任意選択ｺﾝﾊﾟｲﾗ選択としてﾌﾟﾛｼﾞｪｸﾄ"GccApplication1 Properties..."の"Advance"設定
から"WinAVR"GNUｺﾝﾊﾟｲﾗである"Toolchain Flavour"を選ぶこともできます。

重要な構成設定:

この開始実演設計のﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞのために次の段階へ続行するために、7.章(ﾊｰﾄﾞｳｪｱ構成設定)で記述されるようにﾊｰﾄﾞｳｪｱ構成
設定が既に行われていることを確実にしてください。また、この資料の4.章(Puttyｿﾌﾄｳｪｱのｲﾝｽﾄｰﾙ)で指示されるようにあなたのｼｽﾃ 
ﾑにPuttyｿﾌﾄｳｪｱ(Windows端末画面ｿﾌﾄｳｪｱ)が既にｲﾝｽﾄｰﾙされているべきです。

注: 端末ｳｨﾝﾄﾞｳとしてPuttyｿﾌﾄｳｪｱを使用する他に、使用者は直接的なｲﾝｽﾄｰﾙや、この資料の5.章で記述される拡張ﾂｰﾙとしてAt 
mel Studioｿﾌﾄｳｪｱ内の別の端末ｳｨﾝﾄﾞｳを使用することもできます。

段階13. "PuTTY Configration"ｳｨﾝﾄﾞｳを開始するために、"Start"、"Program"または"All Programs"、"PuTTY"、そして再び"PuTTY"
任意選択を選択してください。

注: この開始実演例はUSB-COMﾎﾟｰﾄ模倣動作ﾃﾞｰﾀを表示するための端末画面ｳｨﾝﾄﾞｳとして"Putty"ｿﾌﾄｳｪｱを利用する方
法を記述します。使用者はそれが先にAtmel Studioｿﾌﾄｳｪｱにｲﾝｽﾄｰﾙされている場合に、ﾌﾟﾗｸﾞｲﾝ端末ｳｨﾝﾄﾞｳを開始し
て使用するためにAtmel Studioから"View"その後に"Terminal Window"任意選択を選択的に選ぶこともできます。このよ
うな場合、使用者はAtmel Studioの拡張管理部からこのようなﾌﾟﾗｸﾞｲﾝ端末ｳｨﾝﾄﾞｳに対して利用可能な設定を調整する
ために、Atmel Studioから"Tools"⇒"Options"⇒"Extensions"⇒"Terminal Window"を選択することもできます。

段階14. "PuTTY Configration"ｳｨﾝﾄﾞｳから"Category"下の"Session"を選び、その後に"connection type"として"Serial"任意選択を許
可/ﾁｪｯｸし、"speed"設定として"9600"を入力し、次に"Serial line"設定として"COMxx"を入力し、そこでそれは"ﾃﾞﾊﾞｲｽ ﾏ
ﾈｰｼﾞｬ"ｳｨﾝﾄﾞｳ(ｺﾝﾋﾟｭｰﾀ/ﾏｲ ｺﾝﾋﾟｭｰﾀ⇒ﾌﾟﾛﾊﾟﾃｨ⇒(ﾊｰﾄﾞｳｪｱ ﾀﾌﾞ)⇒ﾃﾞﾊﾞｲｽ ﾏﾈｰｼﾞｬ)から"USB Serial Port"に対して検出さ
れた"COMxx"ﾎﾟｰﾄ番号設定と一致しなければなりません。

注: この開始実演例はUSB-COMﾎﾟｰﾄ模倣動作ﾃﾞｰﾀを表示するための端末画面ｳｨﾝﾄﾞｳとして"Putty"ｿﾌﾄｳｪｱを利用する方
法を記述します。使用者はそれが先にAtmel Studioｿﾌﾄｳｪｱにｲﾝｽﾄｰﾙされている場合に、ﾌﾟﾗｸﾞｲﾝ端末ｳｨﾝﾄﾞｳを開始し
て使用するためにAtmel Studioから"View"その後に"Terminal Window"任意選択を選択的に選ぶこともできます。このよ
うな場合、使用者はAtmel Studioの拡張管理部からこのようなﾌﾟﾗｸﾞｲﾝ端末ｳｨﾝﾄﾞｳに対して利用可能な設定を調整する
ために、Atmel Studioから"Tools"⇒"Options"⇒"Extensions"⇒"Terminal Window"を選択することもできます。

図8-2. PuTTY Configurationｳｨﾝﾄﾞｳとﾃﾞﾊﾞｲｽ ﾏﾈｰｼﾞｬ ｳｨﾝﾄﾞｳ

段階15. "Saved Sessions"として"XPLORE_EXAMPLE"を入力して"PuTTY Configuration"ｳｨﾝﾄﾞｳから"Save"任意選択を選んでくださ
い。

段階16. "PuTTY Configuration"ｳｨﾝﾄﾞｳから"Category"下の"Terminal"任意選択を選び、その後に"Local echo"に対して"Force on"
を許可/ﾁｪｯｸし、"Local line editing"設定として"Force on"任意選択も許可/ﾁｪｯｸしてください。
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段階17. "PuTTY Configuration"ｳｨﾝﾄﾞｳから"Connection"の"SSH"下の"Serial"任意選択を選び、その後に"Serial line to connect 
to"の右側に正しいCOMﾎﾟｰﾄ(COMxx)番号と以下のｼﾘｱﾙ ﾎﾟｰﾄ設定も指定されていることを確実にしてください。

ｼﾘｱﾙ線形態設定

Speed(Baud) : 9600
Data bits : 8
Stop bits : 1
Parity : None
Flow control : XON/XOFF

段階18. "COMxx - PuTTY"端末ｳｨﾝﾄﾞｳを開始するために"PuTTY Configuration"ｳｨﾝﾄﾞｳから"Open"を選んでください。

段階19. "COMxx - PuTTY"端末ｳｨﾝﾄﾞｳと"ﾃﾞﾊﾞｲｽ ﾏﾈｰｼﾞｬ"ｳｨﾝﾄﾞｳを最小化し、その後にAtmel Studioｳｨﾝﾄﾞｳを使用するように選択
を切り返してください。

段階20. Atmel Studioｿﾌﾄｳｪｱから"Tools"⇒"AVR Tools Firmware Upgrade"を選んでください。

段階21. 接続ﾂｰﾙが検出された場合に"AVR Tools Firmware Upgrade"ｳｨﾝﾄﾞｳから"Upgrade"を選んでください。ｿﾌﾄｳｪｱによって正
しいﾂｰﾙが検出されない場合、基板のPDI接続と電力供給を調べてください。

段階22. "AVR Tools Firmware Upgrade"ｳｨﾝﾄﾞｳで"Upgrade Done"ﾒｯｾｰｼﾞが表示された時は"Close"を選んでください。

段階23. "Solution Explorer"ｳｨﾝﾄﾞｳから"GccApplication1"または"ObjProject1"を強調表示にし、その後に"Properties"任意選択を
選択するためにﾏｳｽの右ｸﾘｯｸを使用してください。

段階24. "Tool"を選び、その後に使用する実際のﾁｯﾌﾟ上ﾃﾞﾊﾞｯｶﾞに依存して"JTAGICE mkII"または"JTAGICE 3"のような"selected 
debugger/programmer"を選択してください。

段階25. 再び"Solution Explorer"ｳｨﾝﾄﾞｳから"Getting_Started_XPLORE.c"ﾌｧｲﾙをﾀﾞﾌﾞﾙｸﾘｯｸしてください。

段階26. 設計ｺｰﾄﾞのﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞを開始するために"Atmel Studio"ｳｨﾝﾄﾞｳの"Debug"ﾒﾆｭｰから"Start Debugging and Break"を選
ぶか、または"Alt+F5"ｷｰﾎﾞｰﾄﾞ ｷｰを使用してください。

段階27. 図8-3.で示されるように設計ｺｰﾄﾞの最後へ
ｽｸﾛｰﾙ ﾀﾞｳﾝしてください。右(図)の命令文
上をｸﾘｯｸし、その後に"Debug"を選んでく
ださい。その後に"Breakpoint"または"Tog 
gle Beakpoint"を選ぶのにﾏｳｽの右ｸﾘｯｸを
使用してください。その後、ﾃﾞﾊﾞｲｽのUART
ﾎﾟｰﾄから1ﾊﾞｲﾄが受信された後でｿﾌﾄｳｪｱ
中断点(ﾌﾞﾚｰｸﾎﾟｲﾝﾄ)を設定するのに"Inse 
rt Breakpoint"を使用してください。

図8-3. ｺｰﾄﾞでの中断点(ﾌﾞﾚｰｸﾎﾟｲﾝﾄ)設定

段階28. ﾏｳｽ ｶｰｿﾙを"ReceiveArray[0]"に置き、"& 0x0F"の前のｺｰﾄﾞからの配列命令文はそこでのｸﾘｯｸなしでｺﾝﾊﾟｲﾗが選択した
SRAMｱﾄﾞﾚｽ位置ﾒｯｾｰｼﾞを表示します。このﾒｯｾｰｼﾞはﾏｳｽの近くに表示されます。UARTから受信するﾊﾞｲﾄに対するｶｰｿﾙ
はAteml Studioｿﾌﾄｳｪｱでｺﾝﾊﾟｲﾙしたｺｰﾄﾞに対して"receiveArray|{uint8_t[1] {data}@0x21ab}"、IARでｺﾝﾊﾟｲﾙされたｺｰﾄﾞに
対して"receiveArray|{uint8_t[1] {data}@0x21f8}"のようになります。

段階29. Atmel Studioで"Memory1"ｳｨﾝﾄﾞｳが自動的に開かれて表示されない場合、"Memory1"ｳｨﾝﾄﾞｳを表示するためにAtmel Studi 
oのﾒﾆｭｰから"Debug"⇒"Windows"⇒"Memory1"を選ぶか、または"Alt+6"ｷｰﾎﾞｰﾄﾞ ｷｰを使用してください。

段階30. "Memory1"ｳｨﾝﾄﾞｳから、ﾒﾓﾘ設定のために"data INTERNAL_SRAM"を選んでください。その後に図8-4.で示されるようにAtm 
el Studioでｺﾝﾊﾟｲﾙしたｺｰﾄﾞに対する"0x21AB,data"または図8-5.で示されるようにIARでｺﾝﾊﾟｲﾙしたｺｰﾄﾞに対する"0x21F8, 
data"のように、受信するﾊﾞｲﾄ"ReceiveArra 
y[0]"として使用される検出された"ｱﾄﾞﾚｽ"
値を入力してください。("Adddress"ﾀﾞｲ ｱﾛ
ｸﾞ ﾎﾞｯｸｽを見るために"Memory1"ｳｨﾝﾄﾞｳが
最大に拡大されていることを確実にしてく
ださい。)

図8-4. SRAMﾃﾞｰﾀ Memory1ｳｨﾝﾄﾞｳ - 本来のGNUｺﾝﾊﾟｲﾗ使用
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図8-5. SRAMﾃﾞｰﾀ Memory1ｳｨﾝﾄﾞｳ - IARｺﾝﾊﾟｲﾗ使用

注: この例ﾌﾟﾛｼﾞｪｸﾄに対するSRAMでのﾃﾞｰﾀ ｱﾄﾞﾚｽ位置0x21ABはｺｰﾄﾞのｺﾝﾊﾟｲﾙにAtmel Studio(GNUｺﾝﾊﾟｲﾗ)が利用され
た場合に受信するﾊﾞｲﾄの格納に使用され得、ﾃﾞｰﾀ ｱﾄﾞﾚｽ位置0x21F8はIAR EWｺﾝﾊﾟｲﾗの場合に受信するﾊﾞｲﾄのため
に使用され得ます。このSRAMｱﾄﾞﾚｽ位置は実際、現実に検出されたSRAM16進ｱﾄﾞﾚｽ位置を示す前の段階に依存しま
す。

段階31. "Atmel Studio"ｿﾌﾄｳｪｱから"Debug"そして"Continue"任意選択を選ぶか、または"F5"ｷｰﾎﾞｰﾄﾞ ｷｰを使用、その後にAtmel 
XMEGAﾃﾞﾊﾞｲｽから端末画面ｳｨﾝﾄﾞｳに送られた以下の初期ﾒｯｾｰｼﾞを見るために"COMxx - PuTTY"端末ｳｨﾝﾄﾞｳを最大に
切り替えてください。

 "What does ATMEL stand for?
 The correct answer is:
 A = PASSION, T = INTEGRITY, M = TEAMWORK, E = ACHIEVEMENT,
 L = ACCOUNTABILITY;
 Please enter the letter 'A' to agree with above answer."

段階32. それで、"COMxx - PuTTY"端末画面ｳｨﾝﾄﾞｳからｶｰｿﾙ/ﾌﾞﾛｯｸを選択してｸﾘｯｸし、何が起こるか見るために指示されたもの
に従わずに、"Shift"ｷｰﾎﾞｰﾄﾞ ｷｰと"C"ｷｰを共に押し、その後に"Enter"ｷｰﾎﾞｰﾄﾞ ｷｰを押すことによって端末ｳｨﾝﾄﾞｳから"A"
ではなく大文字の"C"を入力することによって行ってみてください。

段階33. "COMxx - PuTTY"端末ｳｨﾝﾄﾞｳを最小化し
てください。さて、ﾃﾞｰﾀ ﾒﾓﾘ ｳｨﾝﾄﾞｳは図8- 
6.または図8-7.で示されるようにｱﾄﾞﾚｽ位置
0x21ABまたは0x21F8(ﾃﾞｰﾀ ﾒﾓﾘ(SRAM)の
UART受信ﾊﾞｲﾄ位置)がASCII文字の"C"
である16進値(43)を含むことを示します。

図8-6. SRAMﾃﾞｰﾀ Memory1ｳｨﾝﾄﾞｳ - 本来のGNUｺﾝﾊﾟｲﾗ使用

図8-7. SRAMﾃﾞｰﾀ Memory1ｳｨﾝﾄﾞｳ - IARｺﾝﾊﾟｲﾗ使用

注: この例ﾌﾟﾛｼﾞｪｸﾄに対するSRAMでのﾃﾞｰﾀ ｱﾄﾞﾚｽ位置0x21ABはｺｰﾄﾞのｺﾝﾊﾟｲﾙにAtmel Studio(GNUｺﾝﾊﾟｲﾗ)が利用され
た場合に受信するﾊﾞｲﾄの格納に使用され得、ﾃﾞｰﾀ ｱﾄﾞﾚｽ位置0x21F8はIAR EWｺﾝﾊﾟｲﾗの場合に受信するﾊﾞｲﾄのため
に使用され得ます。このSRAMｱﾄﾞﾚｽ位置は実際、現実に検出されたSRAM16進ｱﾄﾞﾚｽ位置を示す前の段階に依存しま
す。

段階34. ﾌﾟﾛｸﾞﾗﾑの走行を続けるために"Debug"そして"Continue"任意選択を選ぶか、または"F5"ｷｰﾎﾞｰﾄﾞ ｷｰを使用してください。

段階35. "COMxx - PuTTY"端末ｳｨﾝﾄﾞｳを選択し、その後にそれを最大化してください。さて、端末画面ｳｨﾝﾄﾞｳに以下のような新しい
ﾒｯｾｰｼﾞが表示されるでしょう。

 "C
 - Please try again. You can only allow entering the letter 'A' to agree with above answer."

段階36. そこで、再び"COMxx - PuTTY"端末画面ｳｨﾝﾄﾞｳを選択してｸﾘｯｸして、何が起こるか見るために、今回は指示されたものに
従って"Shift"ｷｰﾎﾞｰﾄﾞ ｷｰと"A"ｷｰを共に押し、その後に"Enter"を押すことによって端末ｳｨﾝﾄﾞｳから大文字の"A"を入力す
ることによって行ってみましょう。
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段階37. "COMxx - PuTTY"端末ｳｨﾝﾄﾞｳを最小化し
てください。さて、ﾃﾞｰﾀ ﾒﾓﾘ ｳｨﾝﾄﾞｳは図8- 
8.または図8-9.で示されるようにｱﾄﾞﾚｽ位置
0x21ABまたは0x21F8(ﾃﾞｰﾀ ﾒﾓﾘ(SRAM)の
UART受信ﾊﾞｲﾄ位置)がASCII文字の"A"
である16進値(41)を含むことを示します。

ﾌﾟﾛｸﾞﾗﾑの走行を続けるために"Debug"そ
して"Continue"任意選択を選ぶか、または
"F5"ｷｰﾎﾞｰﾄﾞ ｷｰを使用してください。

図8-8. SRAMﾃﾞｰﾀ Memory1ｳｨﾝﾄﾞｳ - 本来のGNUｺﾝﾊﾟｲﾗ使用

図8-9. SRAMﾃﾞｰﾀ Memory1ｳｨﾝﾄﾞｳ - IARｺﾝﾊﾟｲﾗ使用

注: この例ﾌﾟﾛｼﾞｪｸﾄに対するSRAMでのﾃﾞｰﾀ ｱﾄﾞﾚｽ位置0x21ABはｺｰﾄﾞのｺﾝﾊﾟｲﾙにAtmel Studio(GNUｺﾝﾊﾟｲﾗ)が利用され
た場合に受信するﾊﾞｲﾄの格納に使用され得、ﾃﾞｰﾀ ｱﾄﾞﾚｽ位置0x21F8はIAR EWｺﾝﾊﾟｲﾗの場合に受信するﾊﾞｲﾄのため
に使用され得ます。このSRAMｱﾄﾞﾚｽ位置は実際、現実に検出されたSRAM16進ｱﾄﾞﾚｽ位置を示す前の段階に依存しま
す。

段階38. "COMxx - PuTTY"端末ｳｨﾝﾄﾞｳを選択し、その後にそれを最大化してください。さて、この実演例の完了のために以下のよう
な別の新しいﾒｯｾｰｼﾞが示されます。これは図8-10.でも示されます。

 "A
 - Congratulations!! You have successfully finished this demo example."

注: このﾌﾟﾛｸﾞﾗﾑは'Atmelの意義'についてあなたに思い出させるように設計されています!

図8-10. 実演完了成功ﾒｯｾｰｼﾞを示すCOMxx - PuTTY端末ｳｨﾝﾄﾞｳ

注: 'A'ASCII文字は2進値にも変換されてXPLORE評価ｷｯﾄ基板上のLED3～0で表示されます。これはXPLORE評価ｷｯﾄ 
ﾊｰﾄﾞｳｪｱがAtmelの意義であなたの同意に従うことを示します。

以下はﾃﾞﾊﾞｯｸﾞ処理を停止し、ﾌﾟﾛｼﾞｪｸﾄを保存し、そしてAtmel Sudioｿﾌﾄｳｪｱを抜け出すための最終段階を示します。

段階39. 端末画面を閉じるために"COMxx - PuTTY"端末ｳｨﾝﾄﾞｳの右上側隅から"×"印をｸﾘｯｸしてください。

段階40. 設計ｺｰﾄﾞのﾃﾞﾊﾞｯｸﾞを停止するために"Debug"その後に"Stop Debugging"任意選択または"Ctrl+Shift+F5"ｷｰﾎﾞｰﾄﾞ ｷｰを選
んでください。

段階41. ﾌﾟﾛｼﾞｪｸﾄを保存するために"File"その後に"Save All"または"Ctrl+Shift+S"ｷｰﾎﾞｰﾄﾞ ｷｰを選んでください。

段階42. "Atmel Studio"ｿﾌｳｪｱを抜け出すために"File"その後に"Exit"または"Alt+F4"ｷｰﾎﾞｰﾄﾞ ｷｰを選んでください。
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8.2. Atmel StudioとIARでのｺﾝﾊﾟｲﾙとﾃﾞﾊﾞｯｸﾞ

Atmel StudioとIAR EWでAtmel ATxmega32A4Uﾃﾞﾊﾞｲｽ用のﾌﾟﾛｼﾞｪｸﾄを開始するには下の記述のように行ってください。

段階1. この開始実演例を演習するためにCｿｰｽ ｺｰﾄﾞとﾍｯﾀﾞ ﾌｧｲﾙを含む"Xplore_Getting_Started"ﾌｫﾙﾀﾞを構成設定するのに"Cﾄﾞﾗ
ｲﾌﾞ"のようなﾛｰｶﾙ ﾄﾞﾗｲﾌﾞにこの開始資料と共に来る"Xplore_Getting_Started.zip"ﾌｧｲﾙを解凍してください。

段階2. PCのﾃﾞｽｸﾄｯﾌﾟから、"Atmel Studio"ｿﾌﾄｳｪｱを開始するために"Atmel Studio"ﾃﾞｽｸﾄｯﾌﾟ ｱｲｺﾝをﾀﾞﾌﾞﾙｸﾘｯｸしてください。

段階3. "Atmel Studio"ｳｨﾝﾄﾞｳから"Tools"その後に"External Tools..."任意選択を選んでください。

段階4. "External Tools"ﾀﾞｲｱﾛｸﾞ ｳｨﾝﾄﾞｳから"Add"釦を選んでください。

段階5. "External Tools"ﾀﾞｲｱﾛｸﾞ ｳｨﾝﾄﾞｳの"Title"区画から"[New Tool1]"のような文を"IAR Compiler"に変更してください。

段階6. 以下と同様なIARｺﾝﾊﾟｲﾗの実行可能ﾌｧｲﾙ ﾊﾟｽとﾌｧｲﾙ名を入力するために"Browse"釦を選んでください。

"C:\Program Files (x86)\IAR Systems\Embedded Workbench 6.0_0\common\bin\IarIdePm.exe"

注: 64ﾋﾞｯﾄのWindows 7ｵﾍﾟﾚｰﾃｨﾝｸﾞ ｼｽﾃﾑ(OS)は通常"Program Files (x86)"ﾃﾞｨﾚｸﾄﾘを使用します。他のWindows OSにつ
いては単に"Program Files"ﾃﾞｨﾚｸﾄﾘが使用されるでしょう。上のﾊﾟｽ設定は実際、先にｲﾝｽﾄｰﾙしたIAR Embedded Workb 
enchｺﾝﾊﾟｲﾗ ｿﾌﾄｳｪｱの現実のﾊﾟｽ位置に基づきます。 

段階7. "External Tools"ﾀﾞｲｱﾛｸﾞ ｳｨﾝﾄﾞｳから"Apply"釦その後に"OK"釦を選んでください。

今や、外部ﾂｰﾙとしてAtmel Studio 6.0またはそれ以降版のｿﾌﾄｳｪｱ ｳｨﾝﾄﾞｳからAVRｺﾝﾊﾟｲﾗ用のIAR Workbenchを呼び出す
ことができます。

段階8. IAR Workbenchｿﾌﾄｳｪｱを開始するために"Atmel Studio"ｿﾌﾄｳｪｱから"Tools"その後に"IAR Compiler"任意選択を選んでく
ださい。

段階9. "IAR Embedded Workbench"ｳｨﾝﾄﾞｳから"Project"その後に"Create New Project"任意選択を選んでください。

段階10. "Create New Project"ｳｨﾝﾄﾞｳから、図8-11.で示されるよう
に、最初に"Externally Build Executable"任意選択選び、
その後に"OK"釦をｸﾘｯｸしてください。

図8-11. Create New Projectｳｨﾝﾄﾞｳ

段階11. "C:\Xplore_Getting_Started\IAR\Getting_Started\"ﾃﾞｨﾚｸﾄﾘを閲覧し、その後に新しいﾌﾟﾛｼﾞｪｸﾄ名として"Getting_started_X 
PLORE.ewp"を入力し、最後に新しいﾌﾟﾛｼﾞｪｸﾄを保存するために"Save"釦を選んでください。

段階12. "Workspace"ｳｨﾝﾄﾞｳのFiles下で"Getting_started_XPLORE - Debug"を選び、そして"Add"その後に"Add Files..."任意選択
を選ぶためにﾏｳｽの右ｸﾘｯｸを使用してください。

段階13. 先に"Getting_started_XPLORE.c"ﾌｧｲﾙを選択し、その後に"Ctrl"ｷｰﾎﾞｰﾄﾞ ｷｰを押して同時に"usart_driver.c"ﾌｧｲﾙを選択
し、最後に"Open"釦をｸﾘｯｸしてください。

段階14. ﾌｧｲﾙを開くためにWorkspaceｳｨﾝﾄﾞｳから"Getting_started_XPLORE.c"ﾌｧｲﾙ上でﾀﾞﾌﾞﾙｸﾘｯｸしてください。

段階15. 最初にWorkspaceｳｨﾝﾄﾞｳから"Getting_started_XPLORE - Debug"を強調表示にし、その後に"IAR Embedded Workbench I 
DE"ｳｨﾝﾄﾞｳから"Project"そして"Options"を選ぶか、または"Alt+F7"ｷｰﾎﾞｰﾄﾞ ｷｰを使用してください。

段階16. "Options for node ..."ｳｨﾝﾄﾞｳが飛び出た時に"General Options"を選んでください。

段階17. "General Options"分類の"Target"ﾀﾌﾞから、図8-12.で示されるように"Processor configuration"として"ATxmega"任意選択そ
の後に"ATxmega32A4U"を選んでください。
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図8-12. Target任意選択設定

段階18. "General Options"分類から"Library Configuration"ﾀﾌﾞを選
び、その後に図8-13.で示されるようにﾗｲﾌﾞﾗﾘ名として"Norm 
al DLIB"を選んでください。

図8-13. ﾗｲﾌﾞﾗﾘ任意選択設定

段階19. 右手側のｳｨﾝﾄﾞｳに移動するために右矢印釦上でｸﾘｯｸする
のにﾏｳｽを使用し、"General Options"分類から"System"ﾀﾌﾞ
を選び、その後に"enable bit difinitions in I/O include files"
任意選択を許可(ﾁｪｯｸ)して、その後にOKをｸﾘｯｸしてくださ
い。この設定は図8-14.で示されます。

図8-14. System設定任意選択
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段階20. 分類から"Linker"その後に"Output"ﾀﾌﾞを選び、次に"Out 
put file"に対するﾃﾞﾊﾞｯｸﾞ出力ﾌｧｲﾙ名として"Getting_start 
ed_XP LORE.dbg"ﾌｧｲﾙでの"override-default"構成設定
を許可(ﾁｪｯｸ)し、その後に図8-15.で示されるように"Othe 
r"を選択して"Output format"として"ubrof-8 (forced)"を
選んでください。

図8-15. ﾘﾝｶ出力設定任意選択

段階21. "Category(分類)"から"Linker"その後に"Extra Output"ﾀ
ﾌﾞを選び、次に"General extra output file"任意選択と"Ov 
erride default"任意選択を許可(ﾁｪｯｸ)し、ﾌｧｲﾙ名も"Getti 
ng_started_XPLORE.hex"に変更し、その後に"Output for 
mat"を"Intel-standard"にすべく選び、最後に"OK"釦を
選んでください。これらの設定は図8-16.で示されます。

図8-16. ﾘﾝｶ追加出力設定任意選択

段階22. IAR Embedded Workbenchｿﾌﾄｳｪｱから"File"そして"Save Workspace"を選んでください。

段階23. "Save Workspace As"ｳｨﾝﾄﾞｳが飛び出した時に"Getting_started_XPLORE.eww"を入力し、その後に"Save"釦をｸﾘｯｸしてく
ださい。

段階24. "Workspace"ｳｨﾝﾄﾞｳから"Getting_started_XPLORE.c"ﾌｧｲﾙを選んでください。

段階25. ﾌﾟﾛｼﾞｪｸﾄをｺﾝﾊﾟｲﾙして構築するために"IAR Embedded Workbench IDE"ﾒﾆｭｰから"Project"そして"Rebuild All"任意選択
を選んでください。

ﾌﾟﾛｼﾞｪｸﾄを保存してIARを抜け出すために以下を実行してください。

段階26. "File"その後に"Save All"任意選択を選んでください。

段階27. "File"その後に"Exit"任意選択を選んでください。

IARでｺﾝﾊﾟｲﾙしたｺｰﾄﾞのﾃﾞﾊﾞｯｸﾞをAtmel Studioで続けるために以下を実行してください。

段階28. Atmel Studioｳｨﾝﾄﾞｳを最大化してください。

段階29. Atmel Studioｿﾌﾄｳｪｱ ｳｨﾝﾄﾞｳから"File"その後に"Open"を選び、そして"Open Object File for Debugging"を選ぶか、または
"Ctrl+O"ｷｰﾎﾞｰﾄﾞ ｷｰを使用してください。



AVR1936 : XPLORE開始の手引き [応用記述] 15

段階30. "Open Object File for Debugging"ｳｨﾝﾄﾞｳから、"C:\Xplore_Getting_Started\IAR\Getting_Started\Debug\Exe\Getting_start 
ed_XPLORE.dbg"ｵﾌﾞｼﾞｪｸﾄ ﾌｧｲﾙを閲覧して構成設定し、その後に図8-17.で示されるように"Project Name"として"ObjProje 
ct1"を、ﾌﾟﾛｼﾞｪｸﾄの"Location"として"C:\Xplore_Getting_Started\IAR"ﾃﾞｨﾚｸﾄﾘを選んでください。

図8-17. Atmel Studioでのﾃﾞﾊﾞｯｸﾞ ｳｨﾝﾄﾞｳ用ｵﾌﾞｼﾞｪｸﾄ ﾌｧｲﾙを開く

段階31. "Next"釦選択後、"Device Family"として"AVR XMEGA 8-bit"を選ぶために"Device Selection"ｳｨﾝﾄﾞｳの最後へｽｸﾛｰﾙ ﾀﾞｳ
ﾝし、その後に"Atxmega32A4U"ﾃﾞﾊﾞｲｽを選び、最後に"Finish"釦を押してください。

段階32. こんなﾌｧｲﾙを開くために"Atmel Studio"ｿﾌﾄｳｪｱの"Solution Explore"ｳｨﾝﾄﾞｳから"Getting_started_XPLORE.c"ﾌｧｲﾙでﾀﾞﾌﾞﾙ
ｸﾘｯｸしてください。

段階33. 全ての設定とﾌﾟﾛｼﾞｪｸﾄを保存するために"File"その後に"Save All"任意選択を選んでください。

重要な構成設定

設計のﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞを実行するために次の段階を続行するには、前の章で記述されるようにﾊｰﾄﾞｳｪｱ構成設定が行われることを確
実にしてください。

段階34. そこで、この開始設計例に対してﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞを実行するために、この資料の8.1.項の段階13.から記述されたのと同じ手続
きに従ってください。

9. XPLORE上のAtmel XMEGAの実装ﾌﾟﾛｸﾞﾗﾐﾝｸﾞ
本章はXPLORE評価ｷｯﾄ基板上のPDIｲﾝﾀｰﾌｪｰｽを通してAtmel ATxmega32A4Uﾃﾞﾊﾞｲｽの実装ﾌﾟﾛｸﾞﾗﾐﾝｸﾞ(ISP)を実行する方法を
記述します。これはIAR Embedded WorkbenchまたはAtmel Studioからのｺﾝﾊﾟｲﾗ使用で設計例のｺｰﾄﾞをｺﾝﾊﾟｲﾙしてﾃﾞﾊﾞｯｸﾞした後で
書き込みﾌｧｲﾙ(*.hex)が既に生成されていると仮定されます。

前章で記述されたのと同じﾊｰﾄﾞｳｪｱ構成設定で、XPLORE評価ｷｯﾄ基板上のXMEGAﾃﾞﾊﾞｲｽのPDI実装ﾌﾟﾛｸﾞﾗﾐﾝｸﾞを実行するため
に、使用者はAtmel Studioを開始し、その後に下で記述される段階的手順に従ってください。

段階1. "Atmel Studio"ｿﾌﾄｳｪｱを開始するために、PCのﾃﾞｽｸﾄｯﾌﾟから、"Atmel Studio"ﾃﾞｽｸﾄｯﾌﾟ ｱｲｺﾝ上でﾀﾞﾌﾞﾙｸﾘｯｸしてください。

段階2. "Open Project"ﾀﾞｲｱﾛｸﾞ ｳｨﾝﾄﾞｳを開始するために、"Start Page"ｳｨﾝﾄﾞｳから"Open Project..."任意選択を選ぶか、またはｿﾌﾄ
ｳｪｱ ﾒﾆｭｰから"File"、"Open"、そして"Project/Solution"任意選択を選んでください。

段階3. 以前に保存されたAtmel Studioﾌﾟﾛｼﾞｪｸﾄを選ぶために、設計ﾌﾟﾛｼﾞｪｸﾄ ﾃﾞｨﾚｸﾄﾘを閲覧してください。

Atmel Studioﾌﾟﾛｼﾞｪｸﾄ ﾌｧｲﾙがAtmel Studio(本来のGNUまたはWinAVR GNU)でｺﾝﾊﾟｲﾙされて構築されたﾌｧｲﾙに基づいて
作成されたなら、以下のﾌｧｲﾙを開くために選択してその後に"Open"釦を選ぶことができます。

"C:\Xplore_Getting_Started\Atmel\Getting_Started\GccApplication1\GccApplication1.cproj"

Atmel Studioﾌﾟﾛｼﾞｪｸﾄ ﾌｧｲﾙがIARでｺﾝﾊﾟｲﾙされて構築されたﾌｧｲﾙに基づいて作成されたなら、以下のﾌｧｲﾙを開くために
選択することができます。

"C:\Xplore_Getting_Started\IAR\ObjProject1\Objproject1\ObjProject1.objproj"

重要な構成設定

設計のﾁｯﾌﾟ上ﾃﾞﾊﾞｯｸﾞを実行するために次の段階を続行するには、前の章で記述されるようにﾊｰﾄﾞｳｪｱ構成設定が行われることを確
実にしてください。

現在使用している現実のJTAGICE mkⅡまたはJTAGICE 3ﾂｰﾙで"AVR tools Firmware Upgrade"手続きが実行されていなかったな
ら、以下の段階を行う前に8.1.項からの段階20.、段階21.、段階22.を終えてください。

段階4. 既存Atmel Studioﾌﾟﾛｼﾞｪｸﾄ読み込み後、"Tools"その後に"Device programming"任意選択を選んでください。
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段階5. "AVR Programming"ｳｨﾝﾄﾞｳから、"Tool"設定として(使用する実際のﾂｰﾙに依存して)"JTAGICE mkII"または"JTAGICE 3"を
選んでください。

段階6. "Device"設定として"ATxmega32A4U"を選び、"Interface"設定として"PDI"も選び、その後に"Apply"釦を押してください。

段階7. 図9-1.で示されるように"AVR Programming"ｳｨﾝﾄﾞｳ
から"Target Voltage"を読むのに"Read"釦を、また
"Device ID"を読むのに別の"Read"釦を選んでく
ださい。

図9-1. Atmel Studioでのﾃﾞﾊﾞｲｽ ﾌﾟﾛｸﾞﾗﾐﾝｸﾞ ｳｨﾝﾄﾞｳ

段階8. "AVR Programming"ｳｨﾝﾄﾞｳの"Interface settings"から"Memories"ﾀﾌﾞを選び、その後にﾃﾞﾊﾞｲｽのﾌﾗｯｼｭ ﾒﾓﾘ ﾌﾟﾛｸﾞﾗﾐﾝｸﾞのた
めのﾌﾗｯｼｭ入力HEXﾌｧｲﾙ(Flash Input Hex file)とﾃﾞｨﾚｸﾄﾘ ﾊﾟｽを指定するのに閲覧釦を選んでください。

前にﾌﾟﾛｼﾞｪｸﾄをｺﾝﾊﾟｲﾙして構築するのにAtmel Studio組み込みｺﾝﾊﾟｲﾗ(本来のGNU/WinAVR GNU)が使用された場合、以
下のﾌﾟﾛｸﾞﾗﾐﾝｸﾞ用HEXﾌｧｲﾙを選ぶことができます。

"C:\Xplore_Getting_Started\Atmel\Getting_Started\GccApplication1\Debug\GccApplication1.hex"

前にﾌﾟﾛｼﾞｪｸﾄをｺﾝﾊﾟｲﾙして構築するのにIARｺﾝﾊﾟｲﾗが使用された場合、以下のﾌﾟﾛｸﾞﾗﾐﾝｸﾞ用HEXﾌｧｲﾙを選ぶことができま
す。

ﾌﾟﾛｸﾞﾗﾐﾝｸﾞ用HEXﾌｧｲﾙを構成設定するために"Open"釦を選ぶことを確実にしてください。

段階9. ﾌﾗｯｼｭ ﾒﾓﾘに入力HEXﾌｧｲﾙをﾌﾟﾛｸﾞﾗﾐﾝｸﾞする(書き込む)ために"Program"釦を選んでください。今や、Atmel XMEGAﾃﾞﾊﾞｲ
ｽはﾌﾟﾛｸﾞﾗﾐﾝｸﾞされ(書き込まれ)ます。使用者はﾌﾟﾛｸﾞﾗﾐﾝｸﾞされた(書き込まれた)ｺｰﾄﾞを検証するために"Verify"釦を選ぶこと
もできます。

段階10. ｼｽﾃﾑのﾃﾞｽｸﾄｯﾌﾟから、"PuTTY Configuration"ｳｨﾝﾄﾞｳを開始するために、"Start"、"Programs"または"All Programs"、"PuT 
TY"を、その後に再び"PuTTY"任意選択を選んでください。

段階11. "PuTTY Configuration"ｳｨﾝﾄﾞｳから"Category"下の"Session"を選び、その後に"Saved sessions"として前に保存された"XPL 
ORE_EXAMPLE"を選んでください。

注: "XPLORE_EXAMPLE"が未だ"Saved sessions"として構成設定されていなければ、この段階を再び試みる前に、この資
料の8.1.項からの段階14.と段階15.を繰り返してください。

段階12. この資料の8.1.項からの段階16.、段階17.、段階18.を繰り返してください。 

段階13. さて、開かれた"COMxx - PuTTY"端末ｳｨﾝﾄﾞｳとで、一度XPLORE評価ｷｯﾄ基板からﾘｾｯﾄ(SW8)釦を押して放してください。
これは"COMxx - PuTTY"端末画面で以下のﾒｯｾｰｼﾞを示すでしょう。

 "What does ATMEL stand for?
 The correct answer is:
 A = PASSION, T = INTEGRITY, M = TEAMWORK, E = ACCHIEVEMENT,
 L = ACCOUNTABILITY;
 Please enter the letter ’A’ to agree with above answer."

段階14. 先の端末画面からの指示された命令に従わないために、ASCII文字"C"("Shift"+"C"ｷｰﾎﾞｰﾄﾞ ｷｰを使用する大文字の"C")
を入力し、その後に"Enter"ｷｰを押してください。

そこで、"COMxx - PuTTY"端末画面から以下の更新されたﾒｯｾｰｼﾞを見るでしょう。

 "C
 - Please try again. You can only allow entering the letter ’A’ to agree with above answer."
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段階15. 次に、端末画面からの指示された命令に従う"同意(Agree)"のために、ASCII文字"A"("Shift"+"A"ｷｰﾎﾞｰﾄﾞ ｷｰを使用する大
文字の"A")を入力し、その後に"Enter"ｷｰを押してください。

そこで、"COMxx - PuTTY"端末画面から以下の更新されたﾒｯｾｰｼﾞを見るでしょう。

 "A
 - Congratulations!! You have successfully finished this demo example."

注: このﾌﾟﾛｸﾞﾗﾑは'Atmelの意義'についてあなたに思い出させるように設計されています!

"COMxx - PuTTY"端末画面ﾒｯｾｰｼﾞが図
9-2.で示されます。

XPLORE評価ｷｯﾄ基板上に配置されたLE 
D3～0も"A"文字を2進値で変換されて示
され、それは"1010"-LED3=OFF、LED2= 
ON、LED1=OFF、LED0=ONです。

これはﾊｰﾄﾞｳｪｱが最後に同意された応答
を確かに追認したことを意味します。

今や、あなたはこのXPLORE評価ｷｯﾄに対
する開始の手引きを、成功裏に完了しまし
た。

図9-2. 検査結果を示すCOMxx - PuTTY端末ｳｨﾝﾄﾞｳ
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 http://www.ftdichip.com/Support/Documents/DataSheets/ICs/DS_FT232R.pdf

[8] LDO (Linear Technology) LT3022ﾃﾞｰﾀｼｰﾄ : http://www.linear.com/product/LT3022

[9] FT232RLﾃﾞﾊﾞｲｽのVCPﾄﾞﾗｲﾊﾞ用ｲﾝｽﾄｰﾙの手引き : http://www.ftdichip.com/Support/Documents/InstallGuides.htm
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[10] Atmel Studioｿﾌﾄｳｪｱ ﾀﾞｳﾝﾛｰﾄﾞ : http://www.atmel.com/tools/atmelstudio.aspx

[11] (Atmel AVRを支援しなければならない)IARｺﾝﾊﾟｲﾗ ｲﾝｽﾄｰﾙ ｿﾌﾄｳｪｱ ﾀﾞｳﾝﾛｰﾄﾞ :
 http://www.iar.com/website1/1.0.1.0/675/1/

[12] (PCへのUSB接続に使用される)Future Technology International IncのFTDI FT2232仮想COMﾎﾟｰﾄ ﾄﾞﾗｲﾊﾞ ﾀﾞｳﾝﾛｰﾄﾞ :
 http://www.ftdichip.com/Drivers/VCP.htm

[13] Microsoft Windows 2000,XP,Vista,7 OS使用の場合、FT232RL用のVCP(仮想COMﾎﾟｰﾄ)は次のｳｪﾌﾞｻｲﾄから直接ﾀﾞｳﾝﾛｰﾄﾞす
ることができます。 : http://www.ftdichip.com/Drivers/CDM/CDM 2.08.24 WHQL Certified.zip

[14] Windows OS用Puttyｿﾌﾄｳｪｱ(Putty.zip)は次のｳｪﾌﾞｻｲﾄからﾀﾞｳﾝﾛｰﾄﾞすることができます。 :
 http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
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